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Overview
TheMulesoft Anaplan v2.0.1 connector enables you to connect your Mule flows to the Anaplan version 2.0 Bulk
API. If you are an existing Anaplan customer, you can use this connector to access and run your import, export,
delete and process actions. You can also upload files independently of imports.

The Anaplan Connector for Mulesoft can be used for import, export, and delete actions in an orchestration of
services that Mulesoft calls a Flow. For example, the Flow you build might:

l Import data into Anaplan from a database, Salesforce.com, or a CSV file

l Export a recently updated Module from Anaplan into a CSV file, or import into a target, such as a database

l Perform data transformations on a schedule

l Delete obsolete data

l Perform a model-to-model import

You configure the Anaplan Connector with credentials to connect to a data source and perform operations. With
theMulesoft Anaplan v2.0.1 connector, you build Anypoint flows that work with:

l Anaplan lists

l Anaplan modules

l Anaplan user access

Note: The Anaplan Mulesoft connector is an alternative to using Anaplan Connect or the Anaplan APIs.
You can use the connector for Import, Export, Delete, and Processes (combinations of Imports,
Exports, and/or Deletes) with the exception that for Processes, connector is limited to model-to-model
Import actions and Delete actions.

Use this guide to help you understand how you can set up and configure a basic flow using the connector.

MuleSoft maintains this connector under the Certified support policy.

Overview
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Prerequisites
To use this connector, you need:

l To be familiar with Anypoint Connectors

l An installation of Anypoint Studio

l AMulesoft account

l An Anaplan account.

You also need basic knowledge of:

l Mule Concepts

l Elements in a Mule Flow

To increase your familiarity with Anypoint Studio, we recommend completing the Anypoint Studio Tutorial.

Prerequisites
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Set up the Environment

1. Install these components:

l Java 8

l ApacheMaven

2. Download Anypoint Studio and install it.

3. ConfigureMaven:

a. Under the Anypoint Studio (Mac or Linux) orWindow (Windows)menu, click Preferences >

Anypoint Studio > Maven.

b. Click Browse to locate the folder where you installed Maven.

c. Click Test Maven Configuration. When the green checkmark is shown, click OK.

Set up the Environment
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4. Install the Anypoint DevKit Plugin:

a. From the Anypoint Studio Help menu, click Install New Software.

b. ClickWork with > Anypoint Devkit Update Site.

c. Click Anypoint Devkit Plugin.

d. Click Next then Finish.

e. Restart AnyPoint Studio.

Set up the Environment
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Install the Connector

Install the connector from Anypoint Exchange:

1. In Anypoint Studio, click the Exchange icon in the taskbar.

2. Click Login in the Exchange popup and Sign in.

Note: To complete this step, you must have a Mulesoft account. You can create an account on
theMulesoft Sign up page.

3. Enter Anaplan in the search box and hit Enter.

4. Click Anaplan Connector then click Install.

5. Follow the remaining instructions to complete the installation of the connector.

6. In Anypoint Studio click Help > Installation Details.

7. Verify that Anaplan Connector appears in the list of installed software.

Note: The steps in the version of Anypoint Studio on your system might be different to the ones
described here.

For information about installing connectors, see Installing Connectors.

Upgrade from an Older Version

If you’re currently using an older version of the connector, a small popup appears in the bottom right corner of
Anypoint Studio with an "Updates Available" message.

1. Click the popup and check for available updates.

2. Click the Connector version checkbox, click Next, and follow the instructions provided on the user

interface.

3. Restart Studio when prompted.

4. After restarting, when creating a flow and using the connector you might be asked which version you

would like to use if several versions of the connector are installed. If this happens, choose the version you

want to use.

Set up the Environment
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Change the Connector Version on an Existing Application

As Anaplan releases new versions of connectors, you might want to use the latest version of that connector in
your Mulesoft App. After installing a new version of the Anaplan connector, Anypoint Studio asks you which
version of the connector you want to use when you attempt to use it.

To choose the version of the Anaplan connector:

1. Drag the Anaplan connector onto the canvas.

2. Select the option you want:

l Click Use Newest to use the latest installed version of the connector.

l Click Use Oldest to use the oldest installed version of the connector.

l Click Choose Manually to select the version you want.

3. Select Remember my decision if you want Anypoint Studio to use this version of the connector for all new

applications that you build in this instance of Anypoint Studio. If the checkbox is cleared, Anypoint Studio

displays the option to choose the version of the Anaplan connector in every new project in which you use

it.

Note: Although Anypoint Studio stores the version of the connector in themule-project.xml file,
it does not support changing the version of the connector by manually editingmule-project.xml.
To change your selection, see Change Connector Selection Preferences.

Change Connector Selection Preferences

You can change the way the actions that Anypoint Studio takes when there is more than one version of a
connector installed.

To change the connector selection preferences:

1. Under the Anypoint Studio (Mac or Linux) orWindow (Windows)menu, click Preferences > Anypoint

Studio > Connectors.

Set up the Environment
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Set up the Environment
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2. Under the Extension version to display in the palette (when several are compatible) section, select the

option you want:

l Select Use newest if you want the palette to show the latest installed version of the connector.

l Select Use oldest if you want the palette to show the oldest installed version of the connector.

Set up the Environment
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3. Under the Extension version to add to the project (when several are compatible) section, select the

option you want:

l Select Use Newest to use the latest installed version of the connector.

l Select Use Oldest to use the oldest installed version of the connector.

l Select Choose Manually to select the version you want.

4. Click OK to save the changes.

Set up the Environment
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Change the Connector Version for an Existing Application

If you are working on an existing Mulesoft application that uses an older version of the Anaplan Mulesoft
connector, you can adjust that application so that it uses the newest version of the connector.

Note: This procedure only changes the version of the connector associated only with the project in
which you are working, not all projects in your instance of Anypoint Studio.

To change an existing application to use the latest version of the Anaplan connector:

1. In Package Explorer start from the root folder of your project, then locate the library associated with the

unwanted version of the connector.

2. Right-click the library, then select Build Path > Remove from Build Path.

3. In Package Explorer, right-click the name of your project, then select Build Path > Add Libraries.

Set up the Environment
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4. In the Add Libraries wizard, select Anypoint Connector Dependencies, then click Next.

5. Select the checkboxes associated with the connector dependencies that you want to add to your projects

class path.

Set up the Environment
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Configure the Connector
You can configure the connector to connect to Anaplan using Basic Authentication or Certificate Authentication.

Basic Authentication

To configure the connector with Basic Authentication for an Export, Import, Execution Action (for a Delete
action), or a Process, these global configuration fields must be completed:

Field Description

Username Enter the Anaplan username to log in with.

Password Enter the corresponding password.

Auth Host

Proxy

Enables you to set a proxy for the Anaplan Authentication Service API endpoint. This is
required if the service is deployed behind a firewall.

Note: If the URI to the authentication service on your system is not
https://auth.anaplan.com, you must enter the URI to the authentication
service on your system.

API Host

Proxy

Enables you to set a proxy for the Anaplan version 2.0 Bulk API endpoint. This is
required if the service is deployed behind a firewall.

Note: If the URI to the version 2 Anaplan API on your system is not
https://api.anaplan.com/2/0/, you must enter the URI to the version 2
Anaplan API on your system.

Enable

Logger
Enable or Disable HTTP logging.

Separator Declare a custom import file field separator.

You can complete these fields in themule-app.properties file or you can set values for each action.

To use theMulesoft Anaplan v2.0.1 connector in your Mule application:

1. Place the connector in your flow as applicable for your use case.

2. Store the authentication, connection or other settings in a Properties file.
Connector configuration is automatically stored by Anypoint Studio as a Global Element that can
be used by another instance of the connector.

3. Click Add (green plus sign ) next to the Connector Configuration box.

4. Select Anaplan: Basic Authentication and click OK.

Configure the Connector
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5. Enter your Username and Password for anaplan.com.

Configure the Connector
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6. Click Test Connection to verify that the credentials work.

7. Click OK to close the Test Connector popup then click OK to save your connection credentials.

Certificate Authentication

You can authenticate your connector session by submitting a certificate that has a valid, recognized external
public certificate authority (CA) as the root certificate.

Note: For more information about CA authentication and the CA Key Store fields, see the Anaplan
Connect v1.4 Guide.

To configure the connector with CA authentication for an Export, Import, Execution Action (for a Delete action),
or a Process, these global configuration fields must be completed:

Configure the Connector
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Field Description

Key Store

Path

Enter the location of your Certificate Authority (CA) Java Key Store (JKS) file. This

specifies the location of the repository containing the CA public key certificates that you

have obtained from a recognized external public certificate authority (CA). Examples of

CAs include Comodo, DigiCert and GlobalSign.

Key Store

Password
Enter the password for the JKS file specified in the Key Store Path.

Key Store

Alias
Enter the alias for the JKS file specified in the Key Store Path.

Auth Host

Proxy

Enables you to set a proxy for the Anaplan Authentication Service API endpoint. This is
required if the service is deployed behind a firewall.

Note: If the URI to the authentication service on your system is not
https://auth.anaplan.com, you must enter the URI to the authentication
service on your system.

API Host

Proxy

Enables you to set a proxy for the Anaplan version 2.0 Bulk API endpoint. This is
required if the service is deployed behind a firewall.

Note: If the URI to the version 2 Anaplan API on your system is not
https://api.anaplan.com/2/0/, you must enter the URI to the version 2
Anaplan API on your system.

Enable

Logger
Enable or Disable HTTP logging.

Separator Declare a custom import file field separator.

You can complete these fields in themule-app.properties file or you can set values for each action.

To use theMulesoft Anaplan v2.0.1 connector in your Mule application:

1. Place the connector in your flow as applicable for your use case.

2. Store the authentication, connection or other settings in a Properties file.
Connector configuration is automatically stored by Anypoint Studio as a Global Element that can
be used by another instance of the connector.

3. Click Add (green plus sign ) next to the Connector Configuration box.

4. Select Anaplan: Certificate Authentication and click OK.

Configure the Connector
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5. Enter the Key Store Path, Key Store Password, and Key Store Alias with which to authenticate with

Anaplan.com.

Configure the Connector
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6. Click Test Connection to verify that the credentials work.

7. Click OK to close the Test Connector popup then click OK to save your connection credentials.

Configure the Connector
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Use the Connector in a Mule Flow
You can carry out these operations with the connector:

l Execute Delete Action

l Execute Export Action (Streaming)

l Execute Export Action (Temporary Files)

l Execute Import Action (Streaming)

l Execute Import Action (Temporary Files)

l Execute Process

l Execute Upload-only Import (Streaming)

l Execute Upload-only Import (Temporary Files)

l Preview Export Action

l Preview File to be Uploaded

l Preview Import Data Source

This section describes the basic steps to configure the elements of a flow and uses the importtemporaryfiles flow
in the Demo Project as an example. Once configured, you can invoke this flow from
http://localhost:8081/importtemporaryfiles. When invoked, the application sends a request to Anaplan to
import data into Anaplan based on the options you set.

Use the Connector in a Mule Flow
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The example in this section shows the way in which you can create a Mule project with a flow containing these
elements:

Element Description

HTTP Connector
Allows your Mule application to connect to web resources through the HTTP or HTTPS

protocol. The HTTP connector receives an HTTP request.

Anaplan

Connector
Enables you to perform operations against one or more Anaplan resources.

Object to JSON Converts Anaplan data to JSON to make it human readable on the browser.

Logger

Logs messages or activity based on the value of a Mule expression. In this application, this logs

the start and completion of Anaplan Integration and displays messages in the Anypoint Studio

console.

Drag the elements onto your application in Anypoint Studio. The flow should look something like this:

Configure Flow Elements

Nearly all Mule elements provide configuration options. You can set these options in these ways:

l By using the building block Properties Editor in the console of the Anypoint Studio visual editor

l By editing the XML the Anypoint Studio XML editor, or in any other XML editing environment

The next step is to configure the elements that you added to your flow:

1. Configure the HTTP Connector

2. Configure the Anaplan Connector

3. Configure the Logger

Use the Connector in a Mule Flow

Version 2.0.1 19 © Anaplan 2018



Configure the HTTP Connector

1. In the Anypoint Studio Visual Editor, click the HTTP building block in your flow to open its Properties

Editor.

For this component, we set an abstract element called a Connector Configuration. This contains
several of the high-level configuration properties. A single Connector Configuration element can
be referenced by as many HTTP connectors as you require.

2. Create a new Connector Configuration element by clicking the green plus sign next to the Connector

Configuration field.

Use the Connector in a Mule Flow
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3. Complete theHost and Port fields. Ensure that Host is localhost and Port is 8081.

4. Enter a value for the required field Path. This forms part of the URL that the flow is to be invoked from, so

in this example, we enter /importtemporaryfiles.

Also notice that the Connector Configuration field now shows theHTTP_Listener_Configuration
reference to the element you just created. Click the edit icon to make further changes to it.

Use the Connector in a Mule Flow
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Configure the Anaplan Connector

Note: To complete this section, you need an Anaplan account. Ensure you have your Anaplan account
credentials Anaplan.

1. Click the Anaplan connector to open its Properties Editor, then complete the fields that appear.
Different fields appear depending on the Operation you select. The cross icon indicates fields
that aremandatory when displayed.

Field Value

Display

Name

Enter Anaplan

This is the name Anypoint Studio displays for the element flow.

Operation

Select the operation you want to carry out, as such as:

l Execute Delete Action

l Execute Export Action (Streaming)

l Execute Export Action (Temporary Files)

l Execute Import Action (Streaming)

l Execute Import Action (Temporary Files)

l Execute Process

l Execute Upload-only Import (Streaming)

l Execute Upload-only Import (Temporary Files)

l Preview Export Action

l Preview File to be Uploaded

l Preview Import Data Source

This example uses the Execute Import Action (Temporary Files) operation.

Import

Source File

Path

Enter the location of the file to be imported into Anaplan. For example:

src/main/resources/Employee Planning.csv

Use the Connector in a Mule Flow
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Field Value

Temporary

Chunk

Folder

Enter the location where chunks are to be temporarily stored prior to being uploaded or

imported.

Upload

Source File

Path

Enter the location of the file to be uploaded to Anaplan.

Workspace Enter theWorkspace Id of themodel to which the file is being imported.

Model Enter theModel Id of themodel to which the file is being imported.

Action Enter the Action Id of the action to be carried out.

Export Enter the Export Id of the export to be carried out.

File Enter the Id of the file to be uploaded.

Import Enter the Import Id of the import action to be carried out.

Import

Chunk Size

(MB)

Enter themaximum size of each chunk in MB. Theminimum value is 1 (for 1MB) and the

maximum value is 50 (for 50MB).

Upload

Chunk Size

(MB)

Enter themaximum size of each chunk in MB. Theminimum value is 1 (for 1MB) and the

maximum value is 50 (for 50MB).

Process Enter the Id of the Anaplan process to run.

Retry

Count
Enter the number of times to retry the action if it fails.

Delete

Source File

Select the checkbox if you want the source file to be deleted after the action has been

carried out. Alternatively, select the hash icon to specify a logical expression for this

attribute.

2. Enter the Connector Configuration.
A red and a note that the config-ref attribute is required might be shown. This indicates that
the connector requires a global connector configuration. You can define this as a global element
where you enter global configuration information once. For more information about Global
Elements, see theMulesoft documentation.

Use the Connector in a Mule Flow
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To complete the connector configuration:

a. Click the plus icon next to the Connector Configuration field.

b. Enter your Anaplan login credentials.

c. Click Test Connection.

Use the Connector in a Mule Flow
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d. If the connection is successful, a Test connection successful popup appears. Click OK to close the

popup.

e. Click OK to save the configuration.

The Connector Configuration field should now be populated with the name of the global
element you created.

Configure the Logger

1. Double-click the STARTLOG element.

2. Enter theMessage: EXECUTE IMPORT ACTION TEMPORARY FILES STARTED

SUCCESSFULLY

3. Double-click the COMPLETELOG element.

4. Enter theMessage: EXECUTE IMPORT ACTION TEMPORARY FILES COMPLETED

SUCCESSFULLY

5. Save the changes (Command - s on Mac, or Ctrl + s on Windows).

There is no need to configure 'Object to JSON' element.

Run the Application

Once you have built, configured, and saved your new application, you are ready to run it on the embedded Mule
server. This is included within Anypoint Studio.

In the Package Explorer:

1. Right-click the project name of your project.

2. Select Run As > Mule Application. If you have not already saved your changes, you are prompted to do

so now.

When the startup process is complete, Studio displays a message in the console that reads, Started app
'anaplan-demo'.

Use the Connector in a Mule Flow
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Use the Application

To use the application, open aWeb browser and enter the URL in the Address bar. For example:
http://localhost:8081/importtemporaryfiles

This initiates a request to the application to carry out the requested action in Anaplan. In the browser, you will
see a response sent by Anaplan to provide you information on the action requested. For example:

{"details":[{"localMessageText":"Next 6 month cells: 60 (25

ignored)","occurrences":0,"type":"lineItemRowsProcessedWithIgnored","value

s":["ignoredCount","25","lineItemName",

"Next 6 month","rowCount","60"],"valueMap":

{"ignoredCount":"25","lineItemName":"Next 6 month","rowCount":"60"}},

{"localMessageText":"Jan18 Plan cells: 60 (25 ignored)",

"occurrences":0,"type":"lineItemRowsProcessedWithIgnored","values":

["ignoredCount","25","lineItemName","Jan18

Plan","rowCount","60"],"valueMap":{"ignoredCount":"25",

"lineItemName":"Jan18

Use the Connector in a Mule Flow
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Plan","rowCount":"60"}}],"failureDumpAvailable":false,"objectId":"11200000

0001","objectName":null,"successful":true,"nestedResults":null,

"pathForTask":null,"rowCount":0,"dumpFiles":null}

When you log in to Anaplan, you should see that the requested action has been carried out.

Use the Connector in a Mule Flow
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Demo Project
The demo project we provide can be a starting point for your Mulesoft project. The demo project contains
sample flows for these operations:

Operation Description

Execute

Delete Action

Runs a preconfigured delete action. Use this option when you want to create a flow to carry out a

delete action that already exists in your model.

Execute

Export Action

(Streaming)

Runs an export using streaming. Use this option when you are creating a flow that exports data

from Anaplan to another cloud service. For example, Anaplan to Salesforce.com orWorkday.

Execute

Export Action

(Temporary

Files)

Runs an export using temporary files. Use this option when you are creating a flow that

downloads the exported data.

Execute

Import

Action

(Streaming)

Uploads and imports a file using streaming. Use this option when you are creating a flow that

imports data from another cloud service. For example, Salesforce.com orWorkday.

Execute

Import

Action

(Temporary

Files)

Uploads and imports data using temporary files. Use this option when you are creating a flow

that imports data from a physical location such as your computer to an Anaplan model.

Execute

Process

Runs a preconfigured Anaplan process. An Anaplan process is a single container that enables

several actions to run in a particular order. Processes can be configured on the Anaplan user

interface by an Administrator user. A process can contain any combination of import, export, and

deletion actions. See Processes.

Demo Project
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Operation Description

Execute

Upload-only

Import

(Streaming)

Uploads a file using streaming. This uploads the data to Anaplan, but it does not import the data

to themodel. Use this option when you are creating a flow that imports data from another cloud

service for example, Salesforce.com orWorkday.

Execute

Upload-only

Import

(Temporary

Files)

Uploads a file using temporary files. Use this option when you are uploading data from a physical

location such as your computer. This uploads the data to Anaplan, but does not import the data

into themodel.

Preview

Export Action

Enables you to preview information about the data to be exported. Amaximum of 20 lines is

shown.

Preview File

to be

Uploaded

This enables you to preview information about the file to be uploaded. Amaximum of 20 lines is

shown.

Preview

Import Data

Source

This enables you to preview the uploaded data to be imported. This shows the first 20 lines of the

first chunk of the file to be imported.

Notes: Use the streaming option if you do not want any data to be stored on disk.

Use the temporary files option for files 30-50MB. This separates data extraction from transfer. Use this
option if you want to push the information to the server without holding the results in memory.

To use the demo project:

l You must know about the Anaplan import, export, process and delete actions

l You must have verified that your Anaplan model already has the actions that your Mule Flowwill

automate.
Note: The Anaplan model you are working with does not assume that the data is coming from a
particular integration.

Demo Project
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l You must know the values for the Variables for Authentication and Configuration for the demo you want

to use such as your Anaplan:

o username

o password

o Key Store Path

o Key Store Password

o Key Store Alias

o workspaceId

o modelId

o exportId

o importId

o deleteActionId

o processId

Export data from Anaplan

You can export data from Anaplan to a Mule connector or component that supports streaming or you can
export to a temporary folder.

Notes: Use the streaming option if you do not want any data to be stored on disk.

Use the temporary files option for files 30-50MB. This separates data extraction from transfer. Use this
option if you want to push the information to the server without holding the results in memory.

Exporting Data using Streaming

You can create a mule flow that exports data from your Anaplan model to a mule connector or a component. For
example, you might want to create a flow that exports data from your Anaplan model to Salesforce:

1. Drag the components you want from theMule palette to your flow.

2. In theMulesoft Anaplan v2.0.1 Connector tab select Execute Export Action (Streaming).

3. Configure the connector to call a valid Anaplan export action by selecting the appropriateWorkspace,

Demo Project
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Model, and Export.

4. Enter a Retry Count.

Exporting to a Temporary Folder

1. Drag the components you want from theMule palette to your flow.

2. In theMulesoft Anaplan v2.0.1 Connector tab select Execute Export Action (Temporary Files).

3. Enter a Temporary Folder.

4. Configure the connector to call a valid Anaplan export action by selecting the appropriateWorkspace,

Model, and Export.

5. Enter a Retry Count.

Import data to Anaplan

You can import large dataset to Anaplan as a stream.

In the case where the import data should be deleted or is not ephemeral, or the source data is not available as a
stream, use temporary files. Use the temporary files option for files 30-50MB if you are extracting data from a
database and want to push the information to the server without holding the results in memory.

Import using Streaming

1. In theMulesoft Anaplan v2.0.1 Connector tab select Execute Import Action (Streaming).

2. Configure the connector to call a valid Anaplan import action by selecting the appropriateWorkspace,

Model, and Import.

3. Enter an Import Chunk Size of 1-50megabytes (MB).

4. Enter a Retry Count.

5. Enter a Stream Reference.

Import using Temporary Files

1. In theMulesoft Anaplan v2.0.1 Connector tab select Execute Import Action (Temporary Files).

2. If you selected Execute Import Action (Temporary Files):

3. Enter an Import Source File Path.

Demo Project
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4. Enter a Temporary Chunk Folderwhere the connector will create the chunk files.

5. Configure the connector to call a valid Anaplan import action by selecting the appropriateWorkspace,

Model, and Import.

6. Enter an Import Chunk Size in megabytes (MB).

7. Enter a Retry Count.

8. Select Delete Source File to delete the data source file on completion.

Execute a Preconfigured Delete Action

You can run a preconfigured delete action in your model. For instance, you might want to delete data from an
Anaplan list.

1. In the connector select Execute Delete Action.

2. Configure the connector to execute a preconfigured delete action model in your Anaplan model by

selecting the appropriateWorkspace,Model, and Delete action.

Execute a Process

You can execute a preconfigured action process containing a combination of import, export, and delete actions.
You can also schedule the process to run at a particular interval:

1. Create a flowwith Poll component and configure the poller as necessary. For example, Cron scheduler.

2. Drag an instance of theMulesoft Anaplan v2.0.1 connector to themain section of the flow.

3. In the connector select Execute Process.

4. Configure the connector to execute on a schedule by selecting the appropriateWorkspace,Model, and

Process action.

Preview a File to be Uploaded

1. In the connector select Preview File to be Uploaded.

2. Configure the connector to fetch themodel import data by selecting the appropriateWorkspace,Model,

and File.
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Preview the Structure of an Import Datasource

1. In the connector select Preview Import Data Source.

2. Configure the connector to fetch themodel import data by selecting the appropriateWorkspace,Model,

and Import.

Preview the Structure of an Export File

1. In the connector select Preview Export Action.

2. Configure the connector to fetch themodel import data by selecting the appropriateWorkspace,Model,

and Export.
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Connector Namespace and Schema
When designing your application in Anypoint Studio, when you drag the connector from the palette onto the
Anypoint Studio canvas, Studio automatically populates the XML code with the connector namespace and
schema location.

Namespace: http://www.mulesoft.org/schema/mule/connector

Schema Location: http://www.mulesoft.org/schema/mule/connector/current/mule-
connector.xsd

Tip: If you aremanually coding theMule application in Studio's XML editor or another text editor,
define the namespace and schema location in the header of your Configuration XML, inside the
`<mule>` tag.

<mule xmlns="http://www.mulesoft.org/schema/mule/core"

xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"

xmlns:connector="http://www.mulesoft.org/schema/mule/connector"

xsi:schemaLocation="

http://www.mulesoft.org/schema/mule/core

http://www.mulesoft.org/schema/mule/core/current/mule.xsd

http://www.mulesoft.org/schema/mule/connector

http://www.mulesoft.org/schema/mule/connector/current/mule-connector.xsd">

<!-- put your global configuration elements and flows here -->

</mule>

Note: Use current in the schema path. Studio interprets this to the current Mule version.

Connector Namespace and Schema
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Maven Dependency Information
For Maven dependency management, include this XML snippet in your pom.xml file.

[source,xml,linenums]

<dependency>

<groupId>org.mule.modules</groupId>

<artifactId>anaplan-connector</artifactId>

<version>2.0.1</version>

</dependency>

Tip: Inside the <version> tags, put the desired version number, the word RELEASEfor the latest
release, or SNAPSHOT for the latest available version. The available versions are:

l 2.0.1

Maven Dependency Information
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Connector Performance
To define the pooling profile for the connector manually, access the Pooling Profile tab in the applicable global
element for the connector.

For background information on pooling, see Tuning Performance.

Connector Performance
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Resources

l For information about Anaplan, see Anapedia.

l For information about the Anaplan version 2.0 API, see Anaplan version 2.0 Bulk API documentation.

Resources
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